i
Plant Ecology & Diversity

ISSN: (Print) (Online) Journal homepage: https://www.tandfonline.com/loi/tped20

Minimum temperature drives community leaf trait
variation in secondary montane forests along a
3000-m elevation gradient in the tropical Andes

Melissa Llerena-Zambrano, Jenny C. Ordofiez, Luis D. Llambi, Masha van der
Sande, Esteban Pinto, Laura Salazar & Francisco Cuesta

To cite this article: Melissa Llerena-Zambrano, Jenny C. Ordofiez, Luis D. Llambi, Masha van
der Sande, Esteban Pinto, Laura Salazar & Francisco Cuesta (2021): Minimum temperature drives
community leaf trait variation in secondary montane forests along a 3000-m elevation gradient in
the tropical Andes, Plant Ecology & Diversity, DOI: 10.1080/17550874.2021.1903604

To link to this article: https://doi.org/10.1080/17550874.2021.1903604

4 . .
h View supplementary material (&' @ Published online: 10 May 2021.
"
@ Submit your article to this journal &' il Article views: 77
4 A\
& View related articles (& K!) View Crossmark data ('
CrussMark

Full Terms & Conditions of access and use can be found at
https://www.tandfonline.com/action/journalinformation?journalCode=tped20


https://www.tandfonline.com/action/journalInformation?journalCode=tped20
https://www.tandfonline.com/loi/tped20
https://www.tandfonline.com/action/showCitFormats?doi=10.1080/17550874.2021.1903604
https://doi.org/10.1080/17550874.2021.1903604
https://www.tandfonline.com/doi/suppl/10.1080/17550874.2021.1903604
https://www.tandfonline.com/doi/suppl/10.1080/17550874.2021.1903604
https://www.tandfonline.com/action/authorSubmission?journalCode=tped20&show=instructions
https://www.tandfonline.com/action/authorSubmission?journalCode=tped20&show=instructions
https://www.tandfonline.com/doi/mlt/10.1080/17550874.2021.1903604
https://www.tandfonline.com/doi/mlt/10.1080/17550874.2021.1903604
http://crossmark.crossref.org/dialog/?doi=10.1080/17550874.2021.1903604&domain=pdf&date_stamp=2021-05-10
http://crossmark.crossref.org/dialog/?doi=10.1080/17550874.2021.1903604&domain=pdf&date_stamp=2021-05-10

PLANT ECOLOGY & DIVERSITY
https://doi.org/10.1080/17550874.2021.1903604

Taylor & Francis
Taylor & Francis Group

’ W) Check for updates

ARTICLE
Minimum temperature drives community leaf trait variation in secondary
montane forests along a 3000-m elevation gradient in the tropical Andes

Melissa Llerena-Zambrano?, Jenny C. Ordofez(®, Luis D. Llambi
Esteban Pinto (¢, Laura Salazar(f and Francisco Cuesta()?

¢, Masha van der Sande (¢,

aGrupo de Investigacion en Biodiversidad, Medio Ambiente y Salud -BIOMAS- Universidad de Las Américas (UDLA), Quito, Ecuador;
bFacultad de Ingenieria Agroindustrial, Universidad de Las Américas, Quito, Ecuador; “Instituto de Ciencias Ambientales y Ecoldgicas
(ICAE), Universidad de Los Andes, Mérida, Venezuela; “Forest Ecology and Forest Management, Wageningen University, The Netherlands;
¢Columbus State University, University System of Georgia, Atlanta, USA; fCentro de Investigacion de la Biodiversidad y Cambio Climatico,
(BioCamb) e Ingenieria en Biodiversidad y Recursos Genéticos, Facultad de Ciencias del Medio Ambiente, Universidad Tecnolégica
Indoamérica, Quito, Ecuador

ARTICLE HISTORY
Received 19 September 2020
Accepted 11 March 2021

ABSTRACT

Background: Leaf functional traits (LFT) influence resource acquisition and are important for
understanding ecosystem processes. Climate and land use are key filters of community
composition and LFT, however, how the relative importance of these filter changes with
elevation has been little studied in the Andes.

Aims: To gain insight into the functional response of Andean forests to climate and distur-
bance in naturally regenerated forest stands.

Methods: We measured leaf blade thickness (LBT), leaf area (LA), specific leaf area (SLA), and
leaf dry matter content (LDMC) from 13 secondary forest communities, along a 3000-m
elevation transect. We derived basal area-weighted mean community (CWM) trait values to
assess the effect of climate and disturbance on the functional structure of regenerating tree
communities.

Results: Community LFT progressively shifted along the elevation gradient driven by changes
in temperature and successional stages towards communities with thicker leaves with low SLA.
Reduction in LDMC with elevation suggested that both succulence and sclerophylly were
important strategies in these forests.

Conclusions: Our findings reinforce the validity of LFT as a powerful predictor to explore the
ecological strategies of tree species in climate scenarios. Warmer conditions could result in
a shift from slower to faster resource acquisition strategies at higher elevations.
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functional diversity relate plant functional traits to
the distribution and abundance of species along
environmental and spatial gradients, the variations
in the structure of plant communities (i.e., patterns
of species abundance) and how in turn these
changes in functional community structure influ-
ence key ecosystem processes (Wright et al. 2004;
Cornwell and Ackerly 2009). Moreover, plant func-
tional types have been key for the development of
mechanistic vegetation dynamic models e.g. Harper
et al. (2018).

Plant functional traits include a wide range of
morpho-physio-phenological
stem, leaves, roots, and reproductive structures
that reflect plant ecological strategies and impact
plant fitness (Reich 2014). Within this group of

Introduction

The seminal work of Tilman and co-workers
(Tilman and Downing 1994; Tilman et al. 2006)
on plant strategies and vegetation dynamics was
key in promoting the study of the relationship
between species diversity and ecosystem function-
ing (Wright et al. 2010; Lefcheck et al. 2015; Zhu
et al. 2016). Analysing functional traits, in addition
to taxonomic diversity is essential for understand-
ing the relationship between biodiversity and eco-
system processes and dynamics (Cornelissen et al.
2003; Tilman et al. 2014; Poorter et al. 2017). Hence,
the study of functional trait diversity has become
a key dimension of community ecology, particularly

characteristics  of

in the analysis of the relationships between plant

community structure and the maintenance of key
ecosystem processes and services such the regula-
tion of water, carbon and nutrient cycles (Kattge
et al. 2011; Poorter et al. 2015). Studies on

traits, leaf traits are the most accessible and cost-
effective to measure for large numbers of species
(Pérez-Harguindeguy et al. 2013). Some of the most
studied leaf traits include leaf blade thickness (LBT),
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leaf area (LA), specific leaf area (SLA), leaf dry
matter content (LDMC) and leaf nutrient concen-
trations. SLA and LDMC are related to plant growth
and litter decomposition (Bakker et al. 2011), car-
bon uptake (Van Der Sande et al. 2017), resource
use strategies, i.e., acquisition vs. conservation (Diaz
et al. 2004; Wright et al. 2004), and response to
gradients of nutrient and water availability
(Garnier et al. 2004; Ordoiiez et al. 2009; Lohbeck
et al. 2012). Species with a short leaf lifespan tend to
have a large SLA (i.e., efficient deployment of leaf
area per unit biomass invested), high nitrogen (N)
concentration, and consequently, high rates of
assimilation and respiration. Conversely, species
with a long leaf lifespan show low SLA and slow
metabolic rates (Llambi et al. 2003; Poorter and
Bongers 2006). LBT and LA are primarily related
with light capture and adaptation to dry or less
fertile (Vaieretti et al. 2007).
Further, trees growing on soils with low P and
N availability tend to have thick leaves, with well-
developed mesophyll and cuticles (Grubb 1977b,
1986).

Traits from individual species can also be used
for studying community and ecosystem properties
based on the biomass ratio hypothesis sensu Grime
(1998) that suggests that primary productivity is
largely determined by the traits of dominant plants
and is therefore relatively insensitive to the abun-
dance of locally rare species (Lavorel and Garnier
2002; Poorter et al. 2017). Hence, evaluating leaf
trait variation of the dominant species can serve as
a proxy to scale up the values of functional traits

environments

from individuals to communities by using commu-
nity-weighted means (CWM) (Diaz et al. 2004;
Ackerly and Cornwell 2007).

Tree community assemblages and ecosystem
processes (e.g., productivity) in tropical Andean
forests (Andean forest hereafter) are constrained
by strong environmental gradients (Malizia et al.
2020). The decrease in temperature of ca.
6 Kkm™' elevation, annual rainfall and air humidity
(Korner 2003; Jarvis and Mulligan 2011), together
with increasing solar and UV radiation at higher
elevations (Cavelier 1996; Halladay et al. 2012;
Fyllas et al. 2017) shape diversity and leaf character-
istics in mountain forests. Trees at higher elevations
are smaller in size and show smaller and thicker
leaves than species at lower elevations (Kappelle
and Leal 1996; Bruijnzeel et al. 2010; Van Der
Sande et al. 2020). These adaptations reflect
increases in LBT and reductions in SLA and LA as
a response to higher UV radiation coupled with

drier and/or colder conditions (Veldzquez-Rosas
et al. 2002; Van De Weg et al. 2009; Fyllas et al.
2017). Such LFT syndromes probably reflect more
conservative, stress tolerant, strategies at higher ele-
vations sensu Grime (1977). The response of LDMC
along elevation gradients has not been extensively
studied in the Andes. There are some mixed results
considering tissue density, with some studies show-
ing an increase and others a decrease in the ratio of
leaf dry mass to fresh mass along environmental
gradients (Van De Weg et al. 2009), so that LDMC
patterns appear to depend on whether sclerophylly
or succulence are the main strategies shaping com-
munity responses (Vendramini et al. 2002).

Plant functional traits are also related to distur-
bance that changes growth conditions. Tree species
growing in younger secondary forests are often
characterised by traits that favour rapid assimilation
and tree growth (high SLA and low LDMC) whereas
forest species of advanced successional stages tend
to have traits related to resource conservation -
high LDMC and low SLA - (Diaz et al. 2004;
Bakker et al. 2011). Forests have a long legacy of
anthropogenic disturbances in many regions of the
Andes (Mathez-Stiefel et al. 2017). For example, on
the western versant of the Ecuadorian Andes, for-
ests have been subject to timber extraction and
conversion to cattle pasture since the middle of the
twentieth century (e.g., Pinto et al. 2018). Past and
current anthropogenic disturbances, together with
natural disturbances owing to the inherent instabil-
ity of steep topographies, have created a highly het-
erogeneous mosaic of different successional stages
throughout these forests (Sylvester et al. 2017).

Given the increasing pressures in recent decades
on these ecosystems due to combined effects of
climate change, land use and land use change,
understanding the recovery dynamics of such sec-
ondary tropical montane ecosystems is of great
importance, given their outstanding levels of biodi-
versity and contribution to global biogeochemical
cycles (Aide et al. 2019; Fadrique et al. 2018). The
use of functional traits could become a way to
characterise how tree community composition and
species abundance patterns in Andean forests are
related to environmental gradients and how they
deviate in response to human disturbance and
thus can be used as indicators of ecosystem recovery
(Chazdon et al. 2007, 2017; Lohbeck et al. 2012).
Moreover, since the response in forest community
structure and composition to environmental
changes can be linked to changes in the morpholo-
gical and physiological traits of trees, understanding



how tree species change their functional traits along
elevation gradients may be used as a space-for-time
substitution to project potential global warming
impacts on the dynamic changes of tree commu-
nities and their effect on ecosystem functions.
Elevation trends in leaf plant morphology are
well documented in mountain forests worldwide
(Cavelier and Goldstein 1989; Leal and Kappelle
1994; Cavelier 1996; Kappelle and Leal 1996; Ledo
et al. 2009; Bruijnzeel et al. 2010). However, the
relationship between environmental and distur-
bance variables and how these interactions shape
tree species and the functional structure of forest
communities in the Andes has been studied in few
localities. Here we report the gradual changes in
CWM leaf functional traits (CWM-LFT) in an
Andean forest along a 3000-m elevation gradient,
and the effect disturbance has on the expected
changes over the leaf traits studied in a new forest
transect located in the western equatorial Andes.
We hypothesised that: (1) CWM-LBT and CWM-
LDMC values would increase, while CWM-LA, and
CWM-SLA would decrease along elevation and
temperature gradients due to the effect of increas-
ingly harsh climate conditions at higher elevations
favouring conservative, stress tolerant, strategies;
(2) Tree communities in an advanced successional
stage would be characterised by lower CWM-SLA
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and CWM-LA values and higher CWM-LDMC and
CWM-LBT values due to the differences in the
resource-use strategies between mid-successional
(acquisitive) and late-successional (conservative)
species.

Materials and methods
Study site

All samples were collected from the ‘Pichincha
long-term forest dynamics and carbon monitoring
transect’, situated on the north-western slope of the
Ecuadorian Andes (Figure 1; Teunissen van Manen
et al. (2019)). The transect is composed of 17 per-
manent plots of 60 m x 60 m where environmental
conditions vary gradually with increasing elevation
(Pinto and Cuesta 2019). Mean annual air tempera-
ture diminishes from 21.6°C at 653 m a.s.l. to 7.2°C
at 3507 m a.s.l.,, whereas minimum annual air tem-
perature (minMAT hereafter), averaged from abso-
lute monthly minimum temperatures, varies from
16.8°C at the lower end of the transect (653 m a.s.l),
decreasing ca. 0.56°C per 100 m a.s.l, reaching
values of 0.7°C at the upper end (3507 m a.s.l;
Table 1).

Forests in the study area are humid evergreen
ecosystems with limited or no seasonality; thus,
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Figure 1. Location of the 13 permanent plots studied along an elevation gradient on the western slope of the equatorial Andes.
Dots and numbers refer to sites in Table 1, ordered by elevation. Grey shading indicates 500-m elevation belts.
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Table 1. Environmental variables and community features of 13 permanent plots along an elevation gradient on the western
versant of the equatorial Andes (hereinafter in 13 locations along an elevation gradient): elevation, minimum annual temperature
(minMAT), relative humidity (RH), annual precipitation (AP), net above-ground biomass productivity (nagg), wood density (WD),
and above ground biomass (AGB). Mapi = Mashpisahungo/Pambilifio; Malo = Mashi Lodge; Mind = Sacha Urcu; Ribr = Rio Bravo;
Inti = Intillacta; Becl = Bellavista Cloud Forest; Cedr = El Cedral Ecolodge; Verd = Verdecocha; Yana = Yanacocha.

Plot Plot Elevation minMAT RH AP NaGB WD AGB
number code (mas.l) (°Q) (%) (mmy™) (Mg ha™"y™) (@cm™) (Mg ha™)
1 Mapi_01 653 16.8 81.5 2075 33 0.523 188
2 Malo_01 827 16.2 66.0 2225 1.7 0.548 179
3 Malo_02 1018 16.4 71.6 2253 24 0.600 317
4 Mind_01 1277 12.2 67.1 2704 1.4 0.498 153
5 Ribr_01 1640 11.0 427 2347 0.8 0.561 110
6 Inti_02 1829 9.6 46.8 1939 1.2 0.518 128
7 Cedr_03 2212 73 56.7 1595 -2.3 0.528 123
8 Becl_01 2313 79 40.1 1471 33 0.581 120
9 Cedr_01 2492 7.9 25.2 1351 -0.5 0.533 114
10 Verd_02 2932 29 453 1251 0.0 0.544 82
11 Verd_03 3109 29 224 1251 -0.2 0.529 80
12 Verd_01 3421 3.7 15.8 1271 0.2 0.582 105
13 Yana_01 3507 0.7 31.1 1377 04 0.598 120

tree species do not lose their leaves throughout
the year. We selected 13 out of the 17 permanent
plots and considered each of them as represen-
tative of the tree community at the site. The
selected communities were separated from each
other by at least 150 m of elevation (Figure 1,
Table 1) and corresponded to early (i.e., second-
ary) and late successional forests affected by
human activities of burning and timber extrac-
tion in the 1980s and 1990s (i.e., secondary
forests sensu lato, given that no complete forest
clearance has occurred in these plots). As such,
the successional stage of the stands was assumed
to have affected their species composition and
community leaf trait scores. To quantify it, we

forest composition, structure, and canopy con-
figuration (Teunissen van Manen et al.,, 2019).

Species selection and leaf trait measurements

Species selection was made based on the biomass
ratio hypothesis (Grime 1998; Van Der Sande et al.
2017). For each plot, we measured leaf traits for
species that contributed 32-76% (average 62% =+
15%) of the total basal area of each plot (Table 2).
This selection criterion resulted in a total of 119
tree species being sampled (5-29 species per plot),
excluding palms and tree ferns, due to technical
constraints to accurately estimate leaf traits in the
field for these growth forms. We acknowledge that,
due to the species selection procedure, two out the
13 plots have a low percentage (<40%) of the total
basal area of each sampled area (Malo_01 and
Cedr_01) represented in the samples. It could be

included disturbance proxies. Currently, these
forests are located within private conservation
which has allowed between 30 and
40 years of ongoing recovery, evidenced in the

reserves,

Table 2. Community-weighted mean values and standard deviation (in brackets) of four-leaf functional traits from 13 permanent
plots (communities) along an elevation gradient on the western slope of the equatorial Andes. Leaf blade thickness (LBT), leaf area
(LA), leaf dry matter content (LDMC) and specific leaf area (SLA). For each community, the table includes total species richness;
number of species collected; number of individual trees and leaves (ca. 10-15 per individual tree) collected and absolute and
relative basal area sampled.

Plot Basal area per  Species Species Basal  Trees Leaves LBT LA SLA LDMC
code plot (m?) richness  collected area (%) (n) (n) (mm) (cm?) (em? g™ (mgg™)
Mapi_01 9.69 74 32 54.2 58 1063 0.266 + 0.07 243.531 £ 25446 22441 £65.16 27392 + 82.64
Malo_01 10.75 106 17 38.8 24 453  0.233 £0.06 230.568 + 154.06 150.59 +64.82 307.60 + 76. 93
Malo_02 13.82 103 17 42.0 25 618 0.216 £ 0.04 208.211 £ 101.63 170.93 £52.44  334.79 + 69.90
Mind_01 11.63 75 19 46.0 42 599 0.244 £ 0.07 123.857 £ 55.78 17543 £44.75 329.23 + 80.90
Ribr_01 9.54 96 18 66.2 35 515 0303 +0.06 123.996 + 12190 131.71 £40.91 293.17 + 77.52
Inti_02 13.82 79 30 46.7 31 581 0.24 £ 0.05 190.262 = 110.50 210.43 £ 105.29 262.66 + 101.09
Cedr_03 7.76 53 18 49.5 33 686 0.298 +0.09 93.602 + 85.93 206.33 + 86.47 216.82 + 80.83
Becl_01 10.44 47 16 64.1 51 889 0314 £0.09 150.084 + 96.91 157.09 £ 57.65 302.35 + 108.89
Cedr_01 11.14 66 12 322 38 569 0373 +0.11 78497 +112.73 126.57 £111.23 280.23 + 79.01
Verd_02 7.54 57 7 52.1 21 296 0.404 £0.11 125311 £ 113.49 142.20 +£ 104.27 215.79 £ 73.75
Verd_03 8.59 41 8 55.9 27 375 0.429 +£0.10 105.547 +£91.05 143.34 £ 62.82 196.28 + 90.72
Verd_01 10.56 39 11 49.0 22 307 0.389+0.08 36.581 +£99.54 105.640 £90.16 286.81 + 74.29
Yana_01 8.30 22 6 75.5 20 264 0403 +£0.06 64.657 +71.02 156.17 £ 53.56  249.03 + 58.13




possible that the species leaf trait values, averaged
at the community level (ie., the basal area-
weighted mean), might differ from the values esti-
mated in this research if a higher number of spe-
cies were included for those two plots. To account
for this potential bias, we made all analyses with
and without the two plots with low basal area
representation, to evaluate if the results were
robust enough despite this limitation (Tables S3-
S6).

We selected three to five individuals with 25 m in
height and 210 cm DBH for each species. Following
standardised protocols (Pérez-Harguindeguy et al.
2013) a sample of about 10-15 fully expanded,
mature leaves (mostly sun leaves) were taken from
each individual. As many as possible of the collected
leaves were collected from trees with a sunlit posi-
tion and leaves had the least amount of herbivory or
other damage (fungal attack, necrosis, or diseases).
Sample collection was carried out between April
and September 2018, starting from the lower end
of the transect. Samples were tagged, bagged, and
placed inside plastic coolers. Each field trip lasted
no more than 3-4 days to preserve the integrity of
the collected leaves before laboratory processing.
On the last day of each field trip, all samples were
transported and cold-stored (4°C) until further ana-
lysis at the Universidad de las Americas, Quito,
Ecuador.

Before processing, all samples were rehydrated
until saturation in water for 24 to 48 h in the
laboratory (Garnier et al. 2001). LA was measured
on fresh leaves without petiole, placing them on
a white background with a 6-cm-long reference
line. They were then covered with a transparent
glass of 100 cm x 70 cm and 4 mm thick to extend
the leaves. A photograph of each leaf was taken with
a Canon Eos rebel T3 digital camera, set on
a support 1 m above the ground. Subsequently, we
imported each photographic image into the Image
J software (Image J version 1.50i, NIH, USA), and
established a size reference measure. For this pur-
pose, we followed these sequential steps: Analyze>
Set scale> Known distance: 6, Length unit: cm,
Global scale. Later, the images were processed
using: Image> Type> 16 bits; Adjust> Threshold.
Finally, we selected each leaf individually using the
‘wand’ tool and then estimated the area of each leaf
using the Analyze> Measure commands. To deter-
mine LBT, we averaged three different measures
taken at three different sections of each leave, avoid-
ing veins as much as possible, with a high precision
digital micrometre (0.001 mm, Starret-series 3732).
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Fresh weight of the water-saturated leaves and dry
leaf weight (oven-dried at 70°C until reaching
a constant weight) were obtained using a high pre-
cision analytical balance (+ 0.002, OHAUS PA153).
We estimated SLA as the fresh leaf area (cm?)
divided by its dry mass (g). Finally, we derived
LDMC by dividing the dry leaf mass by the fresh
leaf mass (mg/g) (Garnier et al. 2001).

Species mean trait values per site were estimated
by averaging trait values obtained from all leaves
collected per species. Between 30 and 75 leaves,
obtained from 3 to 5 selected individuals following
Pérez-Harguindeguy et al. (2013). We excluded the
upper and lower 2.5% quantiles of the leaf data
before calculating means (Table S7). Quantiles
were used rather than the absolute maximum and
minimums to reduce the influence of outliers
potentially caused by errors in the laboratory or at
digitising (Cuesta et al. 2020).

To assess differences in community-level leaf
traits among the 13 plots, basal area-weighted
mean (also known as the community-weighted
mean, CWM) trait values were calculated for the 4
leaf traits, following Cornwell and Ackerly (2009).

S5 aij * tij
Ziszi aij

Where S is the total number of species considered,
aij corresponds to the abundance (i.e. basal area) of
the i-th species on the plot j, and tij is the value of
the trait in the i-th species in plot j. Species trait
values used for the estimation of community
weighted means were log;, transformed to satisty
normality assumptions (Sokal and Rohlf 2011).

CWM = (1)

Environmental and disturbance data

Mean minimum annual air temperature
(minMAT) and Relative Humidity (RH hereafter)
data were registered at each plot between 2016 and
2018, with HOBO Pro Temp/RH data loggers
(U23-001; Onset, USA) at one-hour intervals and
1 m above ground level within the forest unders-
tory (Teunissen van Manen et al. 2019).
Temperature loggers were placed below the stan-
dard meteorological convention of 2 m height to
prevent the direct incidence of sunlight on the data
logger (as loggers have no UV-shield) and damage
from branch and tree falls which are frequent in
successional Andean forests. For estimated annual
precipitation (hereafter ‘precipitation’) we used
information from the CHELSA dataset at 1 km?
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resolution (Karger et al. 2017). In total, the envir-
onmental gradients across the transect spanned
7.2- 21.6°C for mean air temperature and 1251-
2771 mm for annual precipitation from the upper
end to the lower end.

To assess the effect of past human disturbance on
CWM leaf traits we used three proxies: (1) Net
above ground biomass (nagg)
(Finegan et al. 2015); (2) community weighted
mean wood density (WD) of each plot, derived
from the individual wood density values of each
tree (Slik et al. 2010), retrieved from an existing
database (see below); and (3) the above-ground
biomass (AGB) of each plot (Aide et al. 2000; Van
Der Sande et al. 2017). Although tree WD is con-
sidered a functional trait, we used it as an indicator
of human disturbance as WD is closely linked to
forest successional stage. Trees that have softer
wood are likely to represent early successional,
light-demanding, fast-growing tree species, whereas
trees that have denser wood are likely to come from
a population of slow-growing, shade-tolerant, late-
successional species. Thus, we assumed that the
community weighted mean WD of coexisting tree
species could be used as a proxy of the successional
stage of the sampled forest stand (Slik et al. 2008).
As elevation related changes in climate could also
affect WD in a correlated fashion, we tested such
a relationship and found no significant correlation
(r* = 0.09; P = 0.3). Therefore, we kept this variable
as a proxy of disturbance. To estimate WD (g cm™>),
we assigned the WD values to each species found in
each plot using the getWoodDensity function from
the BIOMASS package (Réjou-Méchain et al. 2017).
For unidentified individuals, we used the average
WD value of all other individuals in the plot.

Annual net above ground productivity (nags)
was derived from two censuses carried out in all
plots during 2015 and 2017, in all trees with DBH >
5 cm (Cuesta et al. unpublished). To estimate nsgp
for each plot, first we estimated the above-ground
biomass (AGB) of each tree using the allometric
equation model developed by Chave et al. (2014),
defined as:

AGB = 0.0673 x (WD x DBH? x H)""";

AGB (kg) is the estimated above-ground biomass,
WD (g cm™) is the tree trunk wood density, DBH
(cm) is the diameter of the tree at breast height
(1.3 m), and H (m) is the estimated total height.
Tree height (H) was estimated using a hypsometer.
The AGB per hectare was then determined by
converting kg to Mg, summing the values for all

productivity

where

trees in a plot, and extrapolating to 1 ha.
Subsequently, AGB net change (nagp Mg ha™
year ') was derived from the annualised difference
between AGB productivity and tree mortality
(Valencia et al. 2009). AGB productivity was
obtained by estimating AGB change due to recruit-
ment and growth between 2015 and 2017, following
Brienen et al. (2015).

Data analyses

To explore the relationships between CWM traits
vs. environmental and disturbance variables, we
redundancy analysis (RDA)
(Legendre and Legendre 2012) after excluding
strongly correlated (Pearson correlation, r < 0.6)
explanatory variables. The explanatory variables
retained included (1) minimum temperature
(minMAT), (2) annual precipitation, (3) CWM-
WD and (4) AGB. Subsequently, the CWM traits
were log, transformed and all variables were nor-
malised using a z-score to account for data that is

carried out a

not dimensionally homogeneous (Anderson et al.
2008). We then constructed a between-plots simi-
larity matrix using Euclidean distance for the CWM
traits, to be used in the RDA. The RDA analysis was
carried out in Permanova in PRIMER 6 (Clarke and
Gorley 2006).

To relate individual environmental factors to
observed CWM traits, we used simple bivariate
linear regressions taking as independent variables:
elevation, minMAT, RH, and precipitation.
Normality of the data was checked using
a Shapiro-Wilk test (Sokal and Rohlf 2011). All
analyses were carried out in JMP 8.0 (SAS 2008).
Elevation was used in addition to minMAT to
explore the possible effects of other environmental
drivers that covary with it e.g., CO, and O, partial
pressures, UV radiation incidence, among others
(Korner 2007).

Lastly, we assessed the combined effect of multi-
ple environmental and disturbance variables in
explaining CWM trait patterns by a multiple regres-
sion analysis using standard least-squares for fitting
a model with each CWM-LFT as the dependent
variable (Sokal and Rohlf 2013). Given the high
correlation between minMAT, elevation, RH, and
precipitation we performed a Principal Component
Analysis (PCA) to summarise environmental effects
in uncorrelated explanatory axes. PCA1 explained
89.2% of the total variance of the temperature vari-
ables and had high loading from minMAT and



Elevation. PCA2 explained 6.3% of the total var-
iance and had high loading of RH and precipitation
(Table S1). Therefore, we only used the PCA1 and
PCA2 as explanatory variables in the subsequent
regression models to represent an overall climate
gradient of temperature (PCA1) and precipitation
(PCA2). Although there is potential loss of informa-
tion, the use of PCAs instead of individual variables
minimises multicollinearity and better captures the
multidimensional environmental gradient of our
study locations (Baez et al. 2015). Mean WD and
AGB were included as response variables represent-
ing successional stage in the regression models. We
excluded nagc because a high correlation (i.e., r >
0.6) with PCA1 and AGB. We selected the best
model for each leaf functional by minimising the
residual mean square and maximising r* (Table S2;
Sokal and Rohlf 2013).

Results

The RDA showed a clear segregation of plots along
elevation in terms of their functional leaf trait com-
munity assemblages (Figure 2). The first ordination
axis accounted for 79.7% of the fitted variation in
functional community similarity, segregating tree
communities along a thermal and precipitation gra-
dient (Table 3). Communities from low elevations
(with thinner and broader leaves) were located on
the right-hand side of the diagram, and commu-
nities from the upper section of the gradient on the
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left (trees with thicker and smaller leaves; Figure 2,
Table 3). The second axis accounted for 18.9% of
total variation and organised tree communities
along a successional gradient not related to eleva-
tion (Table 3). Particularly for communities from
low elevations the WD gradient clearly divided
communities with high levels of disturbance
(Inti_02, Mapi_01, Mind _01) characterised by
trees with somewhat higher CWM-SLA and low
CWM-LDMC from communities of mature forests
at similar elevations (Malo_01 and Malo_02,
Ribr_01, Figure 2, Table 2). For communities at
high elevations the pattern linked with disturbance
was less clear and differences in WD were less
marked. A similar ordination resulted from the
analysis when the two plots under-sampled in
terms of basal area were excluded (Table S3;
Figure S1).

The linear regressions showed a significant trend
for three of the four traits along the elevation gra-
dient (Figure 3). CWM-LBT showed a significant
positive relationship with elevation (r* = 0.84; P <
0.0001) while CWM-LA (r> = 0.77; P < 0.0001) and
CWM-SLA (r* = 0.46; P < 0.01) showed a negative
relationship. Tree communities at the two lowest
elevations had thinner mean + SE (0.25 + 0.02 mm)
and larger (237.1 £9.2 cm?) leaves than leaves from
the three highest elevations where were nearly twice
as thick (0.41 + 0.02 mm) and much smaller (68.9 +
34.7 cm?®). Leaves with the largest SLA also
decreased monotonically from 224.4 cm® g

T Elevation (m.a.s.l)
5 WD e 500
2 —) ® 1000
s . RIBR_01 o
> 2000
= Wi YANA_01
£ ! /e . BECL_O1 —— 2500
£ VERD_01 | - ® 3000
* ° | o MALO_01
] [ ]
-2 [ \ __minMAT|
g 07 | ===
£ | VERD_02 ~AGB ]
3 CEDR_O1  INTI_02 MAPI_01
S VERD_03 o o
5 * MIND_01
S a4 \ CEDR_03
<
(o]
o
=
B+ ] S

7 ! T f : ;

..3 —2 = | 0 1 2 3

dbRDA1 (79.7% of fitted, 58.6% of total variation)

Figure 2. Distance-based redundancy analysis (dbRDA) for 13 locations (communities) along an elevation gradient on the western
versant of the equatorial Andes, based on four community-weighted mean leaf functional traits (species data) vs. minimum air
temperature (minMAT), annual precipitation (AP), above-ground biomass (AGB), and wood density (CWM-WD), as explanatory
variables. Dots with identical colour combination indicate plots within the same elevation range.
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Table 3. Correlation coefficients between environmental vari-
ables and axis scores from a distance-based Redundancy
Analysis (dbRDA) based on four functional leaf traits recorded
in 13 locations along an elevation gradient on the western
slope of the equatorial Andes. The first axis accounted for the
79.7% of total variation, while the second axis accounted for
18.9% of total variation. Correlations > 0.5 are represented in
bold. Signs reflect arbitrary selection of gradient direction by
Primer 6.0. for minimum air temperature (minMAT), annual
precipitation (AP), community-weighted mean wood density
(WD) and above-ground biomass (AGB).

Variable RDA1 RDA2 RDA3 RDA4
minMAT (°C) 0.680 0.072 0.727 -0.058
AP (mm) 0.525 0.312 —-0.471 0.636
WD (g cm™3) -0.177 0.942 0.050 -0.279
AGB (Mg ha™") 0.480 —-0.096 —-0.496 -0.717

at the lowest elevation to a mean value of 130.9 cm?
g~' +35.7 at the highest elevation sites (Table 2).
CWM-LDMC, although showed a tendency to
decrease along the elevation gradient, this relation
was not statistically significant (r* = 0.182; P =
0.081). The results were similar when the two out-
lier plots were excluded from the analyses
(Table S4).

The results of the linear regressions between
CWM traits and environmental variables suggested
that minimum temperature was the single strongest
environmental predictor among our variables of
CWM trait changes along the elevation gradient
(Figure 3). CWM-LBT had a significant negative
relationship with minMAT (r2 = 0.818; P <
0.0001), RH (r* = 0.689; P < 0.001) and precipitation
(r* = 0.722; P < 0.001), whereas CWM-LA had
a significant positive relationship with minMAT
(r = 0.671; P < 0.001), RH (r* = 0.656; P < 0.001)
and precipitation (r* = 0.414; P < 0.05). CWM-SLA
had a positive relationship with minMAT (r* =
0.322; P < 0.05) and RH (r* = 0.608; P < 0.01) but
no significant relationship with precipitation.
Lastly, CWM-LDMC had a significant positive rela-
tionship with precipitation (r* = 0.303; P < 0.05) and
minMAT (r* = 0.294; P < 0.05), but not with RH
(r2 = 0.035; P = 0.26) (Figure 3). The exclusion of
the two plots with low basal area (Malo_01 and
Cedr_01) produced similar relationships between
the CWM leaf traits and the environmental vari-
ables (Table S5).

Multiple regression analyses showed that varia-
tion in the four CWM-LFT was related differently to
the thermal/elevation gradient (PCA1l) and past
human disturbances (i.e., WD, AGB; Table 4).
Changes along the elevation gradient in CWM-
LBT and CWM-LA were only driven by climatic
variables (PCA1l, PCA2) and disturbance effects
were not significant. On the contrary, the variation

of CWM-SLA was related primarily to disturbance
(Table 4). CWM-SLA decreased in communities
with lower AGB and high WD (Table 4). Lastly,
variation in CWM-LDMC was related to an inter-
action of a thermal/elevation gradient (PCA1) com-
bined with community mean WD (Table 4). LDMC
decreased with a reduction in air temperature along
the elevation gradient and decreased in commu-
nities composed of trees with low WD (Table 2).
The regression models that excluded the two outlier
plots returned similar results (Table S6).

Discussion

We assessed how community-weighted mean
(CWM) leaf traits change along elevation, and
how these changes can be explained by environ-
mental variables related to climate and disturbance.
Our findings agreed with the elevation trend in leaf
functional traits previously described in the Andes
and other tropical locations (for references see
Table 5) and to our understanding of the relation-
ship between environmental and disturbance dri-
vers in affecting tree species and in shaping the
functional structure of and communities along ele-
vation gradients. We first discuss how CWM traits
varied along the elevation gradient and then evalu-
ate what we think drives spatial variation in CWM
leaf traits. Finally, we discuss the value of using
CWM traits as a tool for improving our under-
standing on how tree communities in Andean for-
ests respond to environmental gradients and human
disturbances using CWM traits as indicators of
ecosystem responses.

CWM trait changes along elevation

We expected that CWM-LBT and CWM-LDMC
values would increase, while CWM-LA, and CWM-
SLA would decrease along the elevation gradient
due to increasingly colder temperatures favouring
conservative, stress tolerant, strategies. Consistent
with our first hypothesis, CWM-LFT changed as
expected, reflecting plant adaptation to harsher con-
ditions as elevation increases. CWM-LBT, CWM-
LA and CWM-SLA were significantly correlated
with elevation while CWM-LDMC was not. Leaf
thickness increased and leaf area together with
SLA decreased with elevation. These results agree
with studies elsewhere that have reported a positive
effect of resource availability on the abundance of
species with acquisitive strategies (Poorter and
Bongers 2006; Poorter et al. 2009; Conti and Diaz
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Figure 3. Bivariate linear regressions between four community-weighted mean leaf functional trait values vs. elevation and
environmental variables: minMAT (°C), RH (%), and AP (mm) along an elevation gradient in Tropical Mountain Forest of the
equatorial Andes: (a) leaf blade thickness (LBT, mm); (b) leaf area (LA, cm?); (c) specific leaf area (SLA, cm? g™"); and (d) leaf dry
matter content (LDMC, mg g~'). Model r* and P values are presented for each trait-elevation combination. Dots with identical
colour combination indicate plots within the same elevation range.

2013; Finegan et al. 2015). As elevation increases,
plant communities shift towards more conservative
resource use strategies and are characterised by
thick and small leaves with low SLA typical of tro-
pical high mountain ecosystems (Llambi et al.
2003). In general, our observed leaf trait patterns
agreed with those inferred from the comparison of
numerous sites distributed over a range of eleva-
tions in different locations of tropical forests (Grubb
1977b; Tanner and Kapos 1982; Givnish 1984; Leal
and Kappelle 1994; Tang and Ohsawa 1999;
Velazquez-Rosas et al. 2002; Poorter and Bongers
2006; Poorter et al. 2008; Wright et al. 2010; Van

Der Sande et al. 2017) as well as from studies along
elevation transects (Enquist et al. 2017; Van Der
Sande et al. 2020), and a recent global meta-
analysis (Midolo et al. 2019; Table 5).

The increasing dominance of species with con-
servative resource-use strategies at higher elevation
may be caused by the marked reduction in the
average annual minimum air temperature from
16°C at 640 m to 0.7°C at 3503 m (Velazquez-
Rosas et al. 2002; Moser et al. 2007; Van De Weg
et al. 2009). Furthermore, the observed changes in
leaf traits are probably a combined response con-
ferring tolerance to reduce water loss due to high
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Table 4. Best-fit models for Leaf blade thickness (LBT), leaf area (LA), leaf dry matter content (LDMC) and specific leaf area (SLA) vs.
environmental and disturbance variables along an elevation gradient on the western slope of the equatorial Andes. The r’adj
coefficient is the proportion of the CWM leaf functional trait variance explained by the model, and the RMSE shows the sum of all
regression errors. We selected the best model for each LFT based on the following criteria: minimise the residual mean square and
maximise the multiple correlation values, 2. Significant relations are represented with an asterisk (*).

Estimate Std Error t ratio Prob>[t| Summary of fit
LBT
Intercept -0.521 0.010 -50.55 <0.0001*
PCA1 0.051 0.006 9.02 <0.0001*
r? adj = 0.87
P < 0,0001%
RSME = 0.037
LA
Intercept 1.937 0.040 48.15 <0.0001*
PCA1 -0.127 0.022 -5.73 0.00019*
PCA2 0.116 0.083 1.384 0.196
r* adj = 0.732
P < 0.0006*
RSME = 0.145
SLA
Intercept 2.778 0323 8.6 <0.0001*
WD -2.088 0.574 -3.640 0.005*
AGB 0.0001 0.0003 3.141 0.0105*
r? adj = 0.58
P = 0.0055*
RSME = 0.062
LDMC
Intercept 1.679 0.266 6.31 0.0001*
WD 1315 0484 272 0.024*
PCA1 -0.029 0.008 -3.49 0.007*
PCA2 -0.059 0.023 197 0.080
r2 adj = 0.58
P =0013*
RSME = 0.052
radiation coupled with low RH and low-  sclerophylly dominates plant responses (Wilson

temperature stress (Niinemets 2001; Vendramini
et al. 2002), which may explain the marked increase
in CWM-LBT and reduction in CWM-LA and
CWM-SLA. This finding agrees with the general
principle espoused by Parkhurst and Loucks
(1972) that states that leat morphology adjusts to
maximise water use efficiency and to avoid excessive
water loss for each unit of CO, acquired under
increasingly harsher environmental conditions.
A progressive reduction in CWM-SLA describes
the decrease of leaf area relative to leaf biomass
and may decrease water loss relative to carbon
gain within a plant canopy (Van De Weg et al.
2009; Liu et al. 2013; Van Der Sande et al. 2017).
Besides, it is possible that small and tough leaves
have a longer lifespan, withstand strong wind, and
suffer less damage from intense radiation.

We expected CWM-LDMC to increase along
elevation as a higher LDMC is usually associated
with more conservative strategies’ characteristic of
stress-tolerant species at high elevations. However,
we found that CWM-LDMC slightly decreased
along the thermal/elevation gradient. The observed
pattern in CWM-LDMC differs from previous glo-
bal analyses, which show that low SLA is accompa-
nied by high LDMC in communities where

and Lee 2000). In our transect, lower elevation
plots, particularly those from earlier successional
stages, were characterised by large leaves with high
SLA and high LDMC, probably due to plant invest-
ments in support tissues (thick rachis) in species
that maintain large leaves (Niinemets et al. 2006).
As elevation increased and conditions become
colder and drier, CWM-LDMC slightly decreased,
in opposition to our expectations. Such patterns
suggest high elevation forest communities in this
transect presented anatomical and morphological
adaptations that seemed to emulate succulence
more than sclerophylly. It has been observed that
for woody perennials in tropical montane forests an
increase in leaf thickness with elevation is a function
of increases in air and water volumes (as well as CO,
assimilation) rather than increases in dry matter
contents as a response to high radiation and drier
conditions (Tanner and Kapos 1982; Cavelier 1996;
Nadal et al. 2018). Stone (2018) has found a similar
pattern, with increases in succulence across the ele-
vation gradient associated with changes in the rela-
tionship in leaf resource investment on an area basis
(i.e., smaller and thicker leaves with increased
investment in air or water space). This finding
argues in favour of a variety of leaf trait strategies
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employed by tropical tree species to cope with harsh
environmental conditions on high mountains.

CWM trait changes and the influence of human
disturbance

We expected that spatial variation in CWM-LFT
would partly be explained by past human land use
(as indicated by AGB, CWM-WD). Specifically, early
successional forests would be expected to be charac-
terised by species with higher SLA, LA and lower
LDMC. The RDA results and the multiple linear
regression analyses supported our second hypothesis
(i.e., the influence of past human disturbances in
explaining spatial changes in CWM traits, particu-
larly at low and mid elevation where disturbance
effects were larger than in locations at the upper
section of the transect). Changes in AGB and com-
munity mean WD (RDA axis 2) seemed to influence
CWM traits. These two proxies of successional stage
of the plots were important in explaining variations
in CWM-LDMC and CWM-SLA. Results from the
regression analyses indicated that younger succes-
sional forest communities (<40 years of recovery)
with low WD and high AGB, were dominated by
species with rapid resource acquisition strategies (i.e.,
high SLA, low LDMC). These early successional
communities (e.g., the plots Mapi_01, Inti_02 and
Mind_01, Table 2) were in fact, dominated by fast-
growing acquisitive species such as Aegiphila alba,
Castilla elastica and Elaeagia utilis (Table S7), with
low WD and very high SLA, that drove the CWM-
SLA upwards in comparison with older forests at
similar elevations. The results of Slik et al. (2008)
have shown the relevance of WD to assess distur-
bance levels across spatial and temporal scales as
a mean to assess forest regeneration. Likewise,
Lohbeck et al. (2013) have found that SLA and LBT
were the only traits that consistently showed com-
munity-level changes during succession in both dry
and evergreen forests in Mexico. The relationship
between WD and SLA at the community level
found in our study reinforces the role of both as
key traits for assessing secondary succession along
environmental gradients in Andean forests.

CWM traits a key tool for improving our
knowledge on dynamics of Andean forests

Our results indicate that species functional traits scaled
up to the community level could depend on (i)
changes in climate drivers along elevation and (ii)
disturbance (Lavorel and Garnier 2002; Chapin

2003). Overall, the response to past disturbance
appears less significant than the decrease in minimum
air temperature and precipitation with increasing ele-
vation in these tropical Andean forests. Nevertheless,
the successional gradient assessed in this study is not
extensive (ie., 20 years in time difference between
plots since disturbance), and hence a stronger effect
of the assessed disturbance proxies could not be
expected. Future research should focus in expanding
the disturbance gradient, including plots from early
succession (<10-20 years) and late succession
(>40 years). This would provide a larger successional
gradient of similar importance to the wide elevation
gradient covered by the current forest transect.

The strong effect of minimum temperature on
CWM leaf traits suggests that ongoing climate change
could strongly alter tree communities, resulting in
species range shifts (Duque et al. 2015; Fadrique
et al. 2018). This could be further accentuated by
differential dispersal abilities of tropical mountain
tree species along elevation gradients, although further
studies are required to evaluate this (Holl et al. 2000;
Chapman et al. 2016). Future research should assess
changes in CWM traits through time via repeated
censuses in these permanent plots which are part of
the Andean Forest Network for long-term monitor-
ing, see Malizia et al. (2020). This research line offers
a unique opportunity to monitor temporal changes in
functional composition and link the functional char-
acteristics of forest communities with species diversity
and ecosystem dynamics (Van Der Sande et al. 2016).
As such, the link between functional traits at species
and community scales with ecosystem dynamics hold
great promise and could constitute a powerful quanti-
tative tool to describe and predict future trends in
tropical mountain ecosystems.
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